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AS319193-L 

3D Modeling with the Best, AutoCAD! 
Vince Sheehan 
Sr. Civil Designer 
 

 

Description 

In this lab, youôll learn how to create 3D geometry using AutoCAD solid, surface, and mesh 
tools. Create 3D assets for Revit families, Civil 3D and InfraWorks models, Inventor software, 
game engines, and other software environments. Edit the 3D objects using various editing tools, 
such as Union, Slice, Extrude Face, Fillet, and so on. Export the 3D objects. This class is 
designed to expand your AutoCAD 3D modeling knowledge. 
 

Speaker(s) 

Vince has been using Autodesk products since 1992. He has been working in the GIS, Civil 
Engineering and Surveying field since 1995. He currently serves as Sr. Designer for a civil 
engineering consulting firm located in Richmond, Virginia. He is also a Design Specialist and 
Blogger on the site Poly In 3D where he writes tutorials and how to tips for Autodesk products. 
Vince has also been 3D modeling and rendering for over 15 years using a verity of Autodesk® 
products and other non-Autodesk® products. Autodesk University 2012 lab speaker on Civil 3D 
2013, Civil View 2013 and 3ds Max Design 2013. Autodesk University 2015 lab speaker on 
Vehicle Tracking 2016. Autodesk University 2017 lab speaker on Autodesk Stingray and 
AutoCAD. 
 
 

vsheehan@comcast.net 

Poly In 3D Blog 

Vincent Sheehan (@vlsheehan) | Twitter 

Vince Sheehan | Linked in 

 
 

 

 
 

Learning Objectives 

¶ Learn how to create 3D Solid, Surface, and Mesh objects using various tools. 

¶ Learn how to edit the objects using tools such as Union, Slice, Extrude Face, Fillet, and so on. 

¶ Learn how to apply texturing and materials to 3D objects. 

¶ Learn how to export the 3D objects to various formats. 

mailto:vsheehan@comcast.net
http://polyin3d.blogspot.com/
https://twitter.com/vlsheehan
https://www.linkedin.com/in/vsheehan
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Launch AutoCAD 2020 

 
3D Modeling Workspace 
Set the workspace to ñ3D Modelingò. This will have all the 
necessary tools to create 3D assets and 3D environments. 
 
 

3D Modeling Ribbon Menus 
Below are the modeling types used in this exercise. 3D Solid, 3D Surface, 3D Mesh and 3D 
Face. 
 
Solid Tab: 

 
 
3D Solid objects consist of primitive shapes and extruded profile. Solids contain volume/mass 
properties. 
 
Surface Tab: 

 
 
3D Surface creation tools are similar to the 3D Solid tools such as sweeping, lofting, extruding, 
and revolving. 3D Surfaces can also be created by blending, patching, offsetting, filleting, and 
extending other surfaces. They do not contain volume/mass properties. 
 
Mesh Tab: 

 
 
3D Mesh is similar to 3D Surfaces. They contain vertices, edges, and faces that use polygonal 
representation. They also do not contain volume/mass properties. 
 
 
 
 
 
 

https://www.autodesk.com/products/autocad/overview
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Coordinates/UCS, Commands, Views, Visual Styles and Draw/System Variables 
 
Adjusting the UCS: 
Click the Home Tab, Coordinates panel. 
Default UCS is World coordinates. Adjust the Z-Axis by click the Z button. Select and object 
face or object intersection the drag the mouse in the direction to establish the Z-Axis. 

 
Dynamic UCS: 
Located in the Status bar. When creating an object, Dynamic UCS temporarily aligns the XY 
plane of the UCS to a planar face on objects such as 3D solids and planar mesh elements. 
 

Views: 
Click the Home tab, View panel or click View Controls on the upper left of the 
workspace. 
[-][SW Isometric][2D Wireframe] 
(The command to turn on the Viewport Controls is VPCONTROL.) 
 
3D Osnap: 
Snaps the cursor to 3D solids, surfaces, and point cloud segments. 
 
Visual Styles: 

Click the View tab, Palettes panel or click Visual Style Controls on the 
upper left of the workspace. 
[-][SW Isometric][2D Wireframe] 
 
Facetres (System Variable): 
Facetres adjust the smoothness of rendered objects and shadows. 
 
Initial calue: 0.5000 
Valid values are from 0.01 to 10.0.  
 
Viewres (Command): 
Controls the sharpness of circles, arcs, splines, and arced polylines 
using short vectors. 
 
Surftab1 (System Variable): 
Sets the mesh density in the M direction for the REVSURF and 
EDGESURF commands. 
 
Surftab2 (System Variable): 
Sets the mesh density in the N direction for the REVSURF and 
EDGESURF commands. 
 
3D Orbit: 
Rotate/Orbit the view in the current viewport. Drag the cursor horizontally, the camera moves 
parallel to the XY plane. Drag the cursor vertically, the camera moves along the Z axis. 
 

https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-E658D5E7-EE5C-4A06-BF34-F71CDB363A71
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-8A5CA7CA-0D59-484E-AA92-AEE0464E8703
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-5B36C4A7-DDBF-4B10-A6F8-7FE542C102A1
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-D2C4AB61-9F54-4513-9921-B959815C6C5E
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-1966BEB9-6975-412B-834E-FD2E85A85330
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-2DF46705-EE9E-409F-86B5-ED391CE207DC
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-77B1C617-E4BB-4D1E-823A-8E2B055B258E
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-8AC3C392-FCE4-432E-844F-183B3BD21303
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-074FCB02-CEEC-4EA2-BA61-2B01D3FD1383
https://help.autodesk.com/view/CIV3D/2020/ENU/?guid=GUID-85CE824C-0AF4-4890-8487-ADBC92BF08F1
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Creating Primitive Objects 
 
Primitive objects are basic 3D shapes made of solid or mesh objects. 

 
1. Solid Primitive Objects. Solid tab, Primitive panel. 

 
a. Box 
b. Cylinder 
c. Sphere 
d. Polysolid 
e. Wedge 
f. Cone 
g. Pyramid 
h. Torus 
i. Show History (Records the history of the solid objects). 

 
 
 
2. Mesh Primitive Objects. Mesh tab, Primitive panel. 

 
a. Mesh Box 
b. Mesh Cone 
c. Mesh Cylinder 
d. Mesh Pyramid 
e. Mesh Sphere 
f. Mesh Wedge 
g. Mesh Torus 
h. REVSURF (Revolve Surface) 
i. EDGESURF (Edge Surface) 
j. RULESURF (Ruled Surface) 
k. TABSURF (Tabulated Surface) 

 
 
3. Drawing Objects. Home tab, Draw panel. 

 
a. Line 
b. Polyline 
c. 3D Polyline 
d. Spline 
e. Helix 
f. Circle 
g. Polygon 
h. Rectabgle 
i. Ellipse 
j. Region 
k. 3DFace 

 
 



 
 

 

Page 5 

Creating Solid Objects 
 
1. Solid objects can be created by several different methods  
 

a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, 
AutoCAD\DWG\Solid Shapes-01.dwgò. 

b. Click Solid tab, Solid panel. 
c. Click Extrude. Select the yellow shapes. Specify height of extrusion of 5 

then press Enter. 
d. Click Presspull. Select the blue Solid object face then move the mouse 

to either side. 
e. Click Revolve. Select the red half lamp shape objects. Snap Endpoint to the bottom left 

#1 then upper left #2. Type 360 then press press Enter. 
f. Click Sweep. Select the cyan circle. Click Alignment in the command line then select 

the cyan polyline. 
g. Click Loft. Select the series of magenta circles. 
h. Click Thicken. Select the green surface object. Type the specifed thickness of 5 then 

press Enter. 

 
 
Creating Surface Objects 
 
1. Surface objects can be created by several 

different methods. 
 

a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, AutoCAD\DWG\Surface 
Shapes-01.dwgò. 

b. Click Surface tab, Create panel. 
c. Click Network. Select the red polylines 1, 2, & 3 then press Enter. Select polylines 4 &5 

then press Enter. 
d. Click Loft. Select the series of magenta circles. 
e. Click Sweep. Select the cyan circle. Click Alignment in the command line then select 

the cyan polyline. 
f. Click Planar. Select the green polygon. 
g. Click Extrude then select the yellow polygons. Specify height of extrusion of 5 then 

Enter. 
h. Click Revolve. Select the red half lamp shape objects. Snap Endpoint to the bottom left 

#1 then upper left #2. Type 360 then press Enter. 
i. Click Blend. Select the green surface circle edge #1 then press Enter. Select the green 

surface circle edge #2 then press Enter. Click the List Icon then select G0, G1 or G2. 
j. Click Patch. Select the top edge of a blue shape then press Enter. Select the List Icon 

then select G0, G1 or G2. 
k. Click Offset. Select the top edge of an orange shape. Type 0.5 then press Enter. 
l. Click Trim 
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Editing 3D Objects 
1. Editing 3D Solid objects can be achieved by several different methods. 

a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, AutoCAD\DWG\Solid 
Shapes-01.dwgò. 

b. Click the Solid Tab on the Ribbon. 
Union 
a. Click the Union button on the Boolean panel. 
b. Select the two red spheres to join together. 

Subtract 
a. Click the Subtract button on the Boolean panel. 
b. Select the two yellow spheres to subtract one object from another. 

Intersect 
a. Click the Intersect button on the Boolean panel. 
b. Select the two cyan spheres to join the objects where they intersect. 

Fillet Edge 
a. Click Fillet Edge button on the Solid Editing panel. 
b. Select an edge marked #1 on the red cube. 

Chamfer Edge 
a. Click the Chamfer Edge button under the Fillet Edge button on the Solid Editing panel. 
b. Select an edge marked #1 on the yellow cube. 

Taper Face 
a. Click Taper Face button on the Solid Editing panel. 
b. Select the face marked #1 on the green cube. 
c. Snap endpoint to #2 then #3. 
d. Type 15 to taper the face 15 degrees. 

Extrude Faces 
a. Click Extrude Faces button on the Solid Editing panel. 
b. Select a face marked #1 on the cyan cube, type a distance of 1 then Enter. 

Offset Faces 
a. Click Offset Faces button on the Solid Editing panel. 
b. Select a face marked #1 on the blue cube, type a distance of 1 then Enter. 

Shell 
a. Click Shell button on the Solid Editing panel. 
b. Select the magenta cube, type a distance of 0.5 then Enter. 

 
2. Editing 3D Surface objects can be achieved by several different methods. 

a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, AutoCAD\DWG\Surface 
Shapes-01.dwgò. 

b. Click the Surface Tab on the Ribbon. 
Fillet 
a. Click the Fillet button on the Edit panel. 
b. Select a blue surface then select the green surface. 
c. Click the Radius in the command line, type 0.5 then Enter. 

Trim 
a. Click the Trim button on the Edit panel. 
b. Select the green surface then Enter. 
c. Select the blue circle then Enter. 
d. Click inside the circle then Enter. The Untrim command will untrim the area.  
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3D Mail Drop Box 
 
1. Constructing a 3D drop box with solids. 

a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, 
AutoCAD\DWG\Dropbox.dwgò. (Outlines of the drop box are already in the 
drawing on the layer ñGUIDELINESò.) 

b. Set DROPBOX layer current. 
c. Click the Extrude button on the Solid tab, Solid panel. 
d. Click Mode in the command line. 
e. Click Solid. 
f. Select the cyan color leg/frame. 
g. Click Path in the command line. 
h. Select the magenta polyline. 
i. Repeat Extrude. 
j. Select the blue square. 
k. Drag the solid up then Snap Endpoint to the bottom corner of the green polyline. 
l. Repeat Extrude. 
m. Select the white rectangle. 
n. Drag the solid outwards then Snap Endpoint to the bottom corner of the green 

polyline. 
o. Repeat Extrude.  
p. Select the green polyline. 
q. Drag the solid across the main box then Snap Endpoint to the corner of the solid. 
r. Click the Solid, Subtract button under the Home tab, Solid Editing panel. (This will 

subtract 3D solids from another.) 
s. Select the solid created in steps p & q then then right click/enter. 
t. Select the solid created in steps m & n then right click/enter. 
u. Click the Solid, Union button under the Home tab, Solid Editing panel.  
v. Select the lower and upper half of the drop box. (This will combine multiple 3D solids 

into a single 3D solid.) 
w. Mirror the leg/frame solid to the opposite side. 

 
2. Assigning Textures and Materials. 
 

a. Refer to steps 8. Assigning Textures and Materials for importing texture 
images and creating materials. 

b. Click the Material Browser button from the Visualize tab, Materials panel or 
type materials from the command line. 

c. Two materials for the drop box are save in the drawing. (MB1 and MB2) 
d. Select the three 3D solids that makeup the drop box. 
e. Right click on the MB1 materials then click Assign to Selection. 
f. Click MB2 then drag it while holding the Control (ctrl) key to the side of the 

drop box. 
g. Repeat step f for the opposite side of the drop box. 
h. To adjust the material mapping, click the Material Mapping button from the 

Visualize tab, Materials panel then while holding the Control (ctrl) key, pick the side 
of the drop box. 
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3D Canopy 
 
1. Constructing a 3D canopy with Surfaces. 

 
a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, AutoCAD\DWG\ 

Canopy.dwgò. (Outlines of the canopy are already in the drawing on the layer 
ñGUIDELINESò) 

b. Set ñCANOPY - COVERò layer current. 
c. Click the Network button under the Surface tab, Create panel. 
d. Select the top yellow polylines then enter. 
e. Select the top red polylines then enter. 
f. Click the Loft button under the Surface tab, Create panel. 
g. Select the lower green and the yellow polylines then enter. 
h. Repeat step ñeò for the left and right side and the back.  
i. Set ñCANOPY - POSTò layer current. 
j. Click the Sweep button under the Surface tab, Create panel. 
k. Select the green circle then enter. 
l. Click Alignment in the command line. 
m. Click Yes to align sweep object perpendicular to path before sweep. 
n. Select the cyan polyline. 
o. Set ñCANOPY - SHELFò layer current. 
p. Click the Extrude button under the Surface tab, Create panel. 
q. Select the brown shelf support polyline then enter then type 0.1 for an extrusion 

height. 
r. Repeat steps ñn ï oò for the rest of the shelf supports. 
s. Click the Extrude button under the Surface tab, Create panel. 
t. Select all the white rectangle polylines then enter then type 8.2 for an extrusion 

height. 
u. Add materials as shown in section 9. (Materials already loaded in drawing) 
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3D Car Wheel 
 
1. Constructing a 3D wheel with solids. 

 
a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, AutoCAD\DWG\Car 

Wheel.dwgò. (Outlines of the wheel are already in the drawing on the layer 

ñGUIDELINESò.) 

b. Click the Solid Tab on the Ribbon. 

c. Set layer 3DWHEEL current. 

d. Click the Revolve button on the Solid panel.  

e. Click Mode in the command line then select Solid. 

f. Select the two green polygons then press Enter. 

g. Specify Axis Start Point. Snap Endpoint to one end of the red centerline then Snap 

Endpoint to the other end of the red centerline. 

h. Type 360 at the command line then press Enter. 

 

 

2. Constructing the lug bolt holes. 

 
a. Set layer 3DWHEEL-HOLES current. 
b. Click the Revolve button on the Solid panel. 
c. Click Mode in the command line then select Solid. 
d. Select the blue polygon then right click or hit Enter. 
e. Specify Axis Start Point. Snap Endpoint to one end of the yellow centerline then Snap 

Endpoint to the other end of the yellow centerline. 
f. Type 360 at the command line then press Enter. 
g. Array the newly created cylinder by typing 3DARRAY at the command line then press 

Enter. 
h. Select the newly created cylinder. 
i. Click Polar in the command line then press Enter. 
j. Click Axis of rotation in the command then press Enter. 
k. Snap Endpoint to one end of the red centerline then Snap Endpoint to the other end of 

the red centerline. 
l. Click Items in the command, type 5 then press Enter twice. 
m. Click the Solid Tab on the Ribbon. 
n. Click the Subtract button on the Boolean panel. 
o. Select the newly created cylinder then press Enter. 
p. Select the center section of the wheel then press Enter. 
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3. Constructing the 3D wheel spokes. 
 
a. Set layer 3DWHEEL SPOKES current. 

b. Click the Surface Tab on the Ribbon. 

c. Click the Loft button on the Create panel. 

d. Click Mode in the command line then select Solid. 

e. Select the two white rectangles then press Enter 

f. Click Guide in the command line, select the cyan polyline then press Enter. 

g. Array the newly created cylinder by typing 3DARRAY at the command line then press 

Enter.  

h. Select the newly created cylinder. 

i. Click Polar in the command line then press Enter. 

j. Click Axis of rotation in the command then press Enter. 

k. Snap Endpoint to one end of the red centerline then Snap Endpoint to the other end of 

the red centerline. 

l. Click Items in the command, type 5 or 6 then press Enter twice. 
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3D Pulley 
 
1. Construct the 3D pulley with the tools solid learned in this handout. 

 
a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, AutoCAD\DWG\Building 

Frame.dwg. (Outlines of the pulley are already in the drawing on the layer 

ñGUIDELINESò.) 

b. Set Pulley layer current. 

c. Extrude the blue close polygon a length of 2.0. 

d. Extrude the green closed polygons 0.10. 

e. Extrude the cyan closed polygons 0.05. 

f. 3DArray the newly created solids around the red centerline. 

g. Revolve the closed magenta polyline 360° around the red centerline. 

h. Subtract the solids created from the blue polyline from the main pulley. 

i. Union the solids created from the green polygons to the main pulley. 

j. Subtract the solid created from the cyan polygon from the main pulley. 
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3D Table and Tablecloth 
 
1. Construct the 3D pulley with the solid and surface tools learned in this handout. 

 
a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, 

AutoCAD\DWG\Table.dwg. (Outlines of the tablecloth are already in the drawing on 

the layer ñGUIDELINESò.) 
b. Set Table layer current. 

c. Extrude the green closed polygons using the cyan polylines ad a path. 
d. Array the table legs around 0,0. 
e. Extrude the magenta circles 0.333. 
f. Subtract the inter solid from the outer solid.  
g. Extrude the red circle 0.0833. 
h. Fillet the top edge of the tabletop 0.05.  
i. Set Tablecloth layer current. 
j. Loft using the lower blue spline and the top blue circle. 
k. Patch the top of the tablecloth using the top blue circle. 
l. Apply a cloth material to the tablecloth. 
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3D Tree 
1. Construct the 3D tree with surface or solid tools learned in this handout. 
 

a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, 

AutoCAD\DWG\Tree.dwgò. 

b. (Outlines of the tree trunk are already in the drawing on the layer ñGUIDELINESò.) 

c. Set the TRUNK SURFACE current. 

d. Loft the magenta closed magenta polylines. 

e. Set LEAVES SURFACE layer current. 

f. Create the leaves using a 3DFACE. 

g. Scatter the leaves around. (3rd party scatter app can be found in the Autodesk 

App Manager under the Add-Ins tab on the ribbon. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

https://apps.autodesk.com
https://apps.autodesk.com/
https://apps.autodesk.com/
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3D Framed Building 
 
1. Complete the building frame with the tools learned in this handout. 

 
a. Open ñC:\DATASETS\AS319193-L - 3D Modeling with the Best, AutoCAD\DWG\Building 

Frame.dwgò.  

b. The closed magenta polyline can be used for Extruding, Revolving, Sweeping, Lofting 

and so on.  
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Assigning Textures and Materials. 
 

a. Open ñC:\DATASETS\AS319193-L - 3D 
Modeling with the Best, 
AutoCAD!\DWG\Dropbox.dwgò. 

b. Isolate layer ñDROPBOXò. 
c. Click the Material Browser button under 

the Visualize tab, Materials panel. 
d. Click the Create New Material button the 

select New Generic Material. (The 
Materials Editor will open) 

e. Rename the material name to 
ñDropbox_01ò. 

f. Click the white image box then select 
Dropbox_01.png from the ñTexturesò folder.  

g. Close the Texture Editor and Materials 
Editor. 

h. Set the Visual Style to ñRealisticò to see the 
materials. 

i. To adjust the material mapping, click the  
Material Mapping button under the 
Visualize tab, Materials panel then while 
holding the ñControlò (ctrl) key, pick the side 
of the drop box. 

j. Repeat for additional materials. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Image from Autodesk Help file. 


